
Aula 7 – Criando seu Primeiro Projeto em 
VR com Unity (Parte 1)
Bem-vindo à jornada de construção de mundos! Você já se imaginou não apenas assistindo a um filme, mas 
vivendo dentro dele? Ou talvez explorando um universo digital como se estivesse realmente lá? A Realidade 
Virtual (VR) torna isso possível, e esta aula é o seu primeiro passo concreto para transformar essa imaginação 
em realidade. Não se preocupe se você é novo neste universo; vamos desmistificar cada etapa, construindo 
um projeto do zero.

Nesta aula, nosso foco é lançar as bases sólidas para sua aventura em VR. Entenderemos como preparar o 
terreno digital, desde a instalação das ferramentas essenciais até a criação de um ambiente virtual simples, 
mas funcional. Ao final, você terá não apenas um projeto inicial rodando, mas também a confiança para 
explorar as infinitas possibilidades que a VR oferece.

Nosso percurso começará com a configuração do ambiente de desenvolvimento, passando pela instalação de 
componentes cruciais para VR dentro do Unity, e culminará na criação de um cenário básico com 
movimentação do jogador. Prepare-se para mergulhar em um processo prático e recompensador, que abrirá 
portas para a criação de experiências imersivas.

Ao final desta aula, você será capaz de:

Configurar o ambiente de desenvolvimento Unity para projetos de VR.

Instalar e configurar os pacotes XR Plugin Management e XR Interaction Toolkit.

Criar um cenário 3D básico com terreno, iluminação e skybox.

Implementar métodos de movimentação do jogador, como teletransporte e locomoção suave.



Preparando o Terreno: Configurando seu 
Ambiente de Desenvolvimento Unity
Imagine que você está prestes a construir uma casa. Antes de colocar o primeiro tijolo, 
você precisa ter as ferramentas certas, o terreno preparado e um plano claro. No 
desenvolvimento de Realidade Virtual, a lógica é a mesma. Nosso "terreno" é o seu 
computador, e nossas "ferramentas" são o Unity Hub, o Unity Editor e os módulos 
específicos para as plataformas que queremos atingir, como Android ou PC. Sem essa 
base, qualquer tentativa de construção seria frustrante e ineficiente.

Unity Hub
Seu centro de comando que 
organiza todas as instalações 
do Unity Editor e seus 
projetos. Permite ter diferentes 
versões instaladas 
simultaneamente.

Unity Editor
Sua oficina onde você 
realmente constrói, programa 
e testa suas experiências VR. 
Aqui você arrasta objetos 3D, 
escreve scripts e configura 
iluminação.

Módulos de Build
Ferramentas especializadas 
que permitem exportar seu 
projeto para dispositivos VR 
específicos como Android ou 
PC.

Instalando o Unity Hub e o Unity Editor

O primeiro passo é visitar o site oficial da Unity (unity.com) e baixar o Unity Hub. Após a instalação do Hub, 
você será guiado para instalar uma versão do Unity Editor. Recomenda-se sempre usar a versão LTS (Long 
Term Support) mais recente, pois ela oferece maior estabilidade e suporte a longo prazo, minimizando 
problemas de compatibilidade.

Ao instalar o Unity Editor, preste atenção especial à seleção dos módulos. Para desenvolver para VR, você 
precisará de pelo menos um dos seguintes:

Android Build Support: Essencial para dispositivos como Oculus Quest/Meta Quest.

Windows Build Support (IL2CPP): Para headsets de PC VR como Valve Index, HTC Vive ou Oculus Rift.



Configurando Módulos Adicionais
Depois de instalar o Editor, você pode adicionar ou remover 
módulos a qualquer momento através do Unity Hub. Basta ir na 
aba "Installs", clicar no ícone de engrenagem da versão do 
Unity que você está usando e selecionar "Add Modules". 
Certifique-se de que os módulos de suporte de construção 
para as plataformas VR que você pretende desenvolver estejam 
marcados.

Exemplo Prático

Se você planeja desenvolver para o Meta Quest 2, 
você precisará do "Android Build Support". Se seu 
foco é o SteamVR em um PC, o "Windows Build 
Support (IL2CPP)" será indispensável. A escolha 
correta aqui economiza muito tempo e evita dores de 
cabeça futuras, garantindo que seu projeto possa ser 
compilado e executado no hardware alvo.

Essa etapa inicial pode parecer um pouco burocrática, mas é a fundação sobre a qual todo o seu projeto de 
VR será construído. Uma configuração bem-feita garante que você terá todas as ferramentas necessárias à 
mão, permitindo que você se concentre na criatividade e na resolução de problemas de desenvolvimento, em 
vez de lutar com a infraestrutura.

Conceito Âmbito/Aplicação Base/Origem Exemplo

Unity Hub Gerenciamento de 
instalações e projetos 
Unity

Ferramenta auxiliar da 
Unity Technologies

Organizar projetos 
para diferentes 
versões do Unity 
Editor.

Unity Editor Ambiente de 
desenvolvimento 
principal

Software de criação 
3D/2D e jogos

Construir cenários, 
programar interações, 
testar experiências VR.

Módulos de Build Suporte para 
exportação para 
plataformas 
específicas

Componentes 
adicionais do Unity 
Editor

Android Build Support 
para Meta Quest; 
Windows Build 
Support para 
SteamVR.



Conectando o Mundo 
Virtual ao Real: XR 
Plugin Management
Com o Unity Editor instalado e os módulos de 
plataforma corretos, você tem sua oficina pronta. 
Mas como essa oficina se conecta aos óculos de 
Realidade Virtual? É aqui que entra o XR Plugin 
Management, um componente vital que atua 
como uma ponte entre o Unity e o hardware de 
VR. Sem ele, o Unity não saberia como 
"conversar" com seu headset VR, seja ele um 
Meta Quest, um Valve Index ou qualquer outro.

Pense no XR Plugin Management como um tradutor universal. 
Cada headset VR fala uma "linguagem" ligeiramente diferente. 
Em vez de você ter que aprender todas essas linguagens e 
programar para cada uma delas individualmente, o XR Plugin 
Management oferece uma interface unificada. Ele gerencia os 
plugins específicos de cada fabricante (como Oculus, 
OpenXR, SteamVR) e os apresenta ao Unity de uma forma 
consistente, simplificando enormemente o processo de 
desenvolvimento e garantindo compatibilidade.

A importância dessa ferramenta cresceu exponencialmente 
com a tendência da Convergência XR, onde VR, AR 
(Realidade Aumentada) e MR (Realidade Mista) se unem. O XR 
Plugin Management é projetado para ser agnóstico ao 
dispositivo, o que significa que ele pode lidar com uma 
variedade de plataformas XR, tornando seu projeto mais 
flexível e preparado para o futuro. Ele é a espinha dorsal que 
permite que seu aplicativo VR funcione em diferentes 
dispositivos sem reescrever grande parte do código.



Instalação e Configuração do XR Plugin 
Management
01

Acesse o Package 
Manager
Abra seu projeto Unity e navegue 
até Window > Package Manager. 
Certifique-se de que o filtro esteja 
definido para "Unity Registry".

02

Instale o XR Plugin 
Management
Procure por "XR Plugin 
Management" e clique em "Install". 
Após a instalação, a seção 
aparecerá em Project Settings.

03

Configure os Provedores 
XR
Vá em Edit > Project Settings > XR 
Plugin Management e marque o 
provedor correspondente ao seu 
dispositivo VR.

Para Meta Quest
Selecione a aba Android no XR Plugin Management 
e marque a caixa "Oculus". Isso instrui o Unity a 
usar o plugin da Oculus para se comunicar com o 
headset.

Para PC VR (OpenXR)
Selecione a aba PC e marque "OpenXR". Isso 
funciona para muitos dispositivos modernos de PC 
VR que usam o padrão OpenXR.

Importante: Essa configuração é um passo crítico. É como conectar o cabo de força do seu aparelho 
na tomada correta. Sem essa conexão, por mais que seu aparelho seja potente, ele simplesmente 
não funcionará. O XR Plugin Management garante que essa "tomada" esteja sempre disponível e 
configurada corretamente para o seu projeto de VR.

Conceito Âmbito/Aplicação Base/Origem Exemplo

XR Plugin Management Gerenciamento de plugins 
para dispositivos XR

Pacote Unity Habilitar suporte 
para Oculus em 
projetos Android 
VR.

Plugins XR (Oculus, 
OpenXR)

Drivers de comunicação 
com hardware VR

Desenvolvidos 
por fabricantes 
ou consórcios

O plugin Oculus 
permite que o 
Unity se 
comunique com 
o Meta Quest.

Convergência XR Fusão de VR, AR e MR Tendência 
tecnológica

Desenvolvimento 
de um aplicativo 
que pode rodar 
em VR e AR com 
o mesmo código 
base.



Interagindo com o Mundo: XR Interaction 
Toolkit
Agora que o Unity consegue "conversar" com o seu headset VR através do XR Plugin 
Management, precisamos dar ao jogador a capacidade de interagir com o mundo 
virtual. É aqui que o XR Interaction Toolkit entra em cena. Ele é um conjunto de 
ferramentas e componentes pré-construídos que simplificam a criação de interações 
comuns em VR, como pegar objetos, apertar botões, teletransportar e muito mais.

Pegar Objetos
Componentes prontos para 
permitir que o jogador pegue e 
manipule objetos virtuais de forma 
natural.

Teletransporte
Sistema de movimentação 
instantânea que reduz o enjoo e 
permite exploração rápida.

Interações UI
Ferramentas para criar interfaces 
de usuário interativas em espaço 
3D.

Imagine que você está em um playground. Você não quer ter que construir cada balanço, escorregador ou 
gangorra do zero. O XR Interaction Toolkit é como um kit de playground pré-fabricado, com todas as peças 
essenciais já projetadas para funcionar bem juntas. Ele economiza um tempo imenso, permitindo que você se 
concentre na experiência única do seu jogo ou aplicativo, em vez de reinventar a roda para cada interação 
básica.

Este toolkit é fundamental para criar uma experiência imersiva e intuitiva. Interações mal projetadas podem 
quebrar a imersão e até causar desconforto ao usuário. Com o XR Interaction Toolkit, você tem acesso a 
padrões de design testados e aprovados, que garantem que suas interações sejam fluidas e naturais, como se 
o usuário estivesse realmente manipulando objetos no mundo real.



Instalação e Configuração do XR 
Interaction Toolkit

Instalando o Pacote
Assim como o XR Plugin Management, o XR 
Interaction Toolkit é um pacote que precisa ser 
instalado via Package Manager. Abra seu 
projeto Unity, vá em Window > Package 
Manager, defina o filtro para "Unity Registry" 
e procure por "XR Interaction Toolkit". Clique 
em "Install".

O XR Origin
Após a instalação, você notará que alguns 
novos componentes e prefabs (objetos pré-
configurados) estarão disponíveis no seu 
projeto. O componente mais importante para 
começar é o XR Origin. Ele representa o 
jogador no mundo virtual e gerencia a posição 
da câmera (os olhos do jogador) e a 
localização dos controladores (as mãos do 
jogador).

Adicionando o XR Origin

Para adicionar um XR Origin à sua cena, clique com o botão direito na hierarquia da cena 
(Hierarchy), vá em XR > XR Origin (VR/AR). Isso criará um objeto na sua cena que contém a câmera 
principal (representando a cabeça do jogador) e os controladores esquerdo e direito.

O XR Origin é o ponto de partida para a maioria das interações em VR. Ele já vem com componentes que 
permitem que a câmera siga o movimento da cabeça do usuário e que os controladores respondam aos inputs 
físicos. É como ter um corpo virtual básico, pronto para ser equipado com habilidades.

Main Camera
Representa a visão do 
jogador, já configurada para 
VR e sincronizada com o 
movimento da cabeça.

XR Controller 
(Esquerdo)
Mapeia os inputs do controle 
físico esquerdo para ações 
virtuais na mão esquerda.

XR Controller (Direito)
Mapeia os inputs do controle 
físico direito para ações 
virtuais na mão direita.

Conceito Âmbito/Aplicação Base/Origem Exemplo

XR Interaction Toolkit Ferramentas para interações 
comuns em XR

Pacote Unity Pegar objetos, 
teletransportar, 
interagir com UI em 
VR.

XR Origin Representação do jogador 
no mundo virtual

Prefab/Compone
nte do XR 
Interaction 
Toolkit

Gerenciar a posição da 
câmera (cabeça) e dos 
controladores (mãos) 
do jogador.

XR Controller Componente para mapear 
inputs dos controles VR

Componente do 
XR Interaction 
Toolkit

Traduzir o movimento 
físico do controle em 
movimento virtual da 
mão.



Construindo seu Primeiro Mundo: Criando 
um Cenário Básico
Com as ferramentas de desenvolvimento e interação configuradas, é hora de começar a 
dar forma ao seu mundo virtual. Não precisamos de algo complexo para começar; um 
cenário básico já nos permite testar as interações e a movimentação. Pense nisso como 
montar um palco simples para uma peça de teatro: você precisa de um chão, um fundo 
e alguma iluminação para que os atores possam se mover e serem vistos.



Elementos Fundamentais do Cenário

Terreno
O chão do seu mundo virtual. 
Pode ser esculpido para criar 
montanhas, vales e planícies, e 
pintado com texturas para 
simular grama, areia ou 
rochas.

Iluminação
Crucial para dar profundidade 
e atmosfera. A Directional 
Light simula a luz do sol, 
criando sombras e definindo o 
clima visual.

Skybox
O "céu" do seu mundo virtual. 
Uma textura 3D que envolve 
toda a cena, criando a ilusão 
de um ambiente vasto e 
contínuo.

Criando um Terreno

O terreno é o chão do seu mundo virtual. Para adicioná-lo, 
clique com o botão direito na hierarquia (Hierarchy), vá 
em 3D Object > Terrain. Isso criará um grande plano 
verde na sua cena.

Com o terreno selecionado, você verá um conjunto de 
ferramentas no Inspector. Você pode usar a ferramenta 
"Paint Terrain" para esculpir montanhas, vales e planícies. 
Experimente diferentes pincéis e configurações de altura 
para criar uma paisagem interessante. É como brincar 
com argila digital, moldando o ambiente conforme sua 
imaginação.

Pintando Texturas

Além de esculpir, você pode "pintar" texturas no terreno para simular grama, areia, rochas ou neve. 
No Inspector do terreno, na aba de pincéis, clique no ícone de "Paint Texture". Você precisará 
adicionar algumas texturas de terreno (geralmente encontradas em pacotes de assets gratuitos ou 
pagos na Asset Store) para poder pintá-las. Isso adiciona detalhes e realismo ao seu ambiente.

Configurando a Iluminação
A iluminação é crucial para dar profundidade e atmosfera ao seu cenário. Sem luz, tudo seria escuro e sem 
vida. Por padrão, o Unity cria uma "Directional Light" (Luz Direcional) em novas cenas, que simula a luz do sol. 
Você pode ajustar sua rotação para mudar a direção das sombras e sua intensidade para controlar o brilho 
geral.

Para uma iluminação mais avançada, você pode adicionar outros tipos de luzes, como "Point Light" (luz 
pontual, como uma lâmpada) ou "Spot Light" (luz focada, como um farol). No entanto, para um cenário básico, 
a Directional Light já é suficiente. Lembre-se que a iluminação em VR impacta diretamente o desempenho, 
então comece simples.

Adicionando um Skybox
O skybox é o que você vê no horizonte, o "céu" do seu mundo virtual. Ele é uma textura 3D que envolve toda 
a sua cena, criando a ilusão de um ambiente vasto e contínuo. Sem um skybox, você veria apenas o vazio 
cinza do Unity.

Para configurar um skybox, vá em Window > Rendering > Lighting. Na janela "Lighting", vá na aba 
"Environment". Em "Skybox Material", você pode selecionar um material de skybox existente ou criar um novo. 
O Unity vem com alguns skyboxes padrão, ou você pode baixar mais da Asset Store. Um skybox simples com 
nuvens ou um gradiente de cores já faz uma grande diferença na imersão.



Movendo-se no Espaço: Implementando a 
Movimentação do Jogador
Com seu cenário básico pronto, o próximo passo é permitir que o jogador se mova 
dentro dele. A movimentação em VR é um tópico crucial, pois afeta diretamente a 
imersão e, mais importante, o conforto do usuário. Movimentos mal implementados 
podem causar enjoo (motion sickness), uma experiência que queremos evitar a todo 
custo. Por isso, o XR Interaction Toolkit oferece soluções robustas para diferentes tipos 
de locomoção.

Teletransporte
Movimentação instantânea de um ponto a outro. 
Ideal para evitar enjoo e exploração rápida de 
grandes áreas.

Locomoção Suave
Simula caminhada ou corrida contínua. Mais 
imersiva, mas requer cuidado para garantir 
conforto.

Existem duas abordagens principais para a movimentação em VR que abordaremos: o teletransporte e a 
locomoção suave (smooth locomotion). Cada uma tem suas vantagens e desvantagens, e a escolha ideal 
muitas vezes depende do tipo de experiência que você está criando e do público-alvo. É como escolher entre 
um teleférico que te leva instantaneamente a um ponto ou uma caminhada gradual pela montanha; ambos 
chegam ao destino, mas a experiência é bem diferente.

O teletransporte é geralmente a opção mais segura para evitar o enjoo, pois o jogador não experimenta o 
movimento contínuo que pode desorientar o cérebro. Já a locomoção suave oferece uma sensação mais 
natural de caminhada, mas exige um cuidado maior na implementação para garantir o conforto. Entender e 
aplicar ambas as técnicas é fundamental para qualquer desenvolvedor de VR.



Teletransporte: O Salto Instantâneo
O teletransporte permite que o jogador se mova 
instantaneamente de um ponto a outro. É uma 
solução excelente para jogos e experiências onde o 
enjoo é uma preocupação, ou onde a exploração de 
grandes áreas precisa ser rápida.

Componentes Necessários
XR Ray Interactor: Adicione este componente 
aos seus controladores (LeftHand Controller e 
RightHand Controller dentro do XR Origin). Ele 
permite que o controlador "aponte" um raio para 
o mundo.

1.

Teleportation Provider: Adicione este 
componente ao seu XR Origin. Ele gerencia as 
requisições de teletransporte.

2.

Teleportation Anchor/Area: Estes são objetos 
na cena que definem onde o jogador pode 
teletransportar.

3.

Teleportation Area
Um plano onde o jogador pode teletransportar 
para qualquer ponto dentro dele. Ideal para áreas 
amplas de exploração.

Teleportation Anchor
Um ponto específico para teletransporte. Perfeito 
para posições exatas como plataformas ou 
pontos de interesse.

Exemplo Prático

Para configurar um Teleportation Area, clique com o botão direito na hierarquia, vá em XR > 
Teleportation Area. Posicione-o no chão do seu cenário. Certifique-se de que o XR Ray Interactor 
nos seus controladores esteja configurado para ativar o raio com um botão específico (geralmente o 
joystick ou um botão lateral). Quando o jogador apontar o raio para a Teleportation Area e pressionar 
o botão, ele será instantaneamente movido para o local.

Smooth Locomotion: A Caminhada Virtual
A locomoção suave simula a caminhada ou corrida contínua no mundo virtual, geralmente controlada por um 
joystick. Embora possa ser mais propenso a causar enjoo em alguns usuários, muitos preferem a sensação de 
controle e imersão que ela oferece.

01

Locomotion System
Adicione este componente ao seu 
XR Origin. Ele gerencia os 
diferentes tipos de locomoção.

02

Continuous Move Provider
Adicione este componente ao seu 
XR Origin. Ele permite a 
movimentação contínua baseada 
em input do controlador. 
Configure-o para usar o joystick do 
controlador (geralmente o 
Primary2DAxis do LeftHand 
Controller).

03

Continuous Turn Provider
Opcional, mas recomendado para 
virar o jogador. Adicione este 
componente ao seu XR Origin e 
configure-o para usar o joystick do 
outro controlador (geralmente o 
Primary2DAxis do RightHand 
Controller). Você pode escolher 
entre "Snap Turn" (virada em 
ângulos fixos, menos enjoo) ou 
"Smooth Turn" (virada contínua, 
mais imersiva mas com maior risco 
de enjoo).

A escolha entre teletransporte e locomoção suave, ou a combinação de ambos, é uma decisão de design 
importante. O teletransporte é como um "atalho" seguro, enquanto a locomoção suave é uma "caminhada" 
mais imersiva. Teste ambas as opções e observe como elas se encaixam na sua experiência e no conforto do 
seu público.



Consolidação e Próximos Passos
Chegamos ao fim da primeira parte da sua jornada na criação de projetos VR com Unity. 
Percorremos um caminho fundamental, desde a preparação do ambiente de 
desenvolvimento com Unity Hub e Editor, passando pela instalação e configuração das 
ferramentas essenciais de VR – o XR Plugin Management para conectar o Unity ao 
hardware, e o XR Interaction Toolkit para habilitar as interações. Além disso, você 
aprendeu a construir um cenário básico com terreno, iluminação e skybox, e a 
implementar os dois principais métodos de movimentação do jogador: teletransporte e 
locomoção suave.

Esta aula não é apenas sobre seguir passos; é sobre construir uma base de conhecimento e habilidades que o 
capacitará a dar vida às suas próprias visões em Realidade Virtual. Você agora tem as ferramentas e o 
entendimento para criar um ambiente virtual funcional e interativo, um verdadeiro ponto de partida para 
experiências mais complexas e envolventes.

Em Prática
Certifique-se de que seu Unity Hub e Editor estão atualizados para uma versão LTS.

Verifique se os módulos de build para sua plataforma alvo (Android ou Windows) estão instalados.

Confirme que o XR Plugin Management está ativado e configurado para o seu headset VR.

Teste as diferentes opções de movimentação (teletransporte e locomoção suave) em seu projeto 
para entender suas nuances.



Autoavaliação

1

Qual componente do Unity é 
responsável por gerenciar as 
instalações do Unity Editor e os 
projetos?
a) Unity Editor
b) XR Plugin Toolkit
c) Unity Hub
d) Package Manager

2

Para desenvolver um aplicativo VR 
para o Meta Quest 2, qual módulo de 
build é essencial instalar no Unity 
Editor?
a) iOS Build Support
b) WebGL Build Support
c) Android Build Support
d) Universal Windows Platform Build Support

3

Qual dos seguintes componentes é 
fundamental para permitir que o Unity 
se comunique com o hardware de 
Realidade Virtual?
a) XR Interaction Toolkit
b) XR Origin
c) XR Plugin Management
d) Continuous Move Provider

4

Ao implementar a movimentação do 
jogador, qual método é geralmente 
considerado mais eficaz para mitigar 
o enjoo?
a) Smooth Locomotion
b) Continuous Turn
c) Teleportation
d) Fly Mode

Questão Dissertativa

5. Explique a importância do XR Interaction Toolkit no desenvolvimento de aplicações VR e cite dois 
tipos de interações que ele facilita.

Gabarito

1
Resposta
c) Unity Hub

2
Resposta

c) Android Build Support

3
Resposta
c) XR Plugin 
Management

4
Resposta

c) Teleportation



Conexão com a 
Próxima Aula
Na Aula 8 – Criando seu Primeiro Projeto 
em VR com Unity (Parte 2), 
aprofundaremos ainda mais em nosso 
projeto. Exploraremos como adicionar 
objetos interativos, implementar a interação 
com as mãos do jogador (como pegar e 
soltar objetos), e criar interfaces de usuário 
básicas em VR. Prepare-se para dar vida ao 
seu mundo com elementos que o jogador 
pode realmente manipular!

Recursos Adicionais
Documentação Oficial do Unity XR
Para detalhes técnicos e atualizações sobre os 
pacotes XR.

Unity Learn
Tutoriais e cursos gratuitos sobre desenvolvimento 
VR.

Asset Store da Unity
Para encontrar modelos 3D, texturas e outros assets 
para seu projeto.

NOTA IMPORTANTE: As informações técnicas 
desta aula estão atualizadas até 2025. 
Consulte sempre fontes oficiais da Unity para 
verificar alterações e as versões mais 
recentes dos pacotes e ferramentas.


